
Welcome!

Thank you for purchasing our  AZ-Delivery  CNC Shield V3 Bundle.  On the 

following pages, you will be introduced to how to use and set up this handy 

device.

Have fun!
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Introduction

The CNC Shield V3.0 Bundle consists of CNC Shield for Uno R3 and 4 

A4988 stepper motor driver modules. The CNC Shield V3.0 can be used as 

drive expansion board for stepper motor drivers. 

There are 4 slots on the board for stepper motor driver modules, and each 

stepper  motor  needs  only  two  I/O  ports.  Shield  supports  A4988  and 

DRV8825 driver types.

 

The CNC Shield V3.0 Bundle suitable for a variety of small and medium 

sized automation equipment and instruments, such as engraving machine, 

marking  machine,  cutting  machine,  laser  typesetting,  plotters,  drawbots, 

CNC machine tools, handling the devices.
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Specifications

Minimum operating voltage 12V

Maximum operating voltage 36V

Continuous Current per phase 1A

Maximum current per phase 2A

Current limit adjustment Analog trim pot

Micro-step resolutions Full, 1/2, 1/4, 1/8, 1/16, and 1/32 steps

Connectors Screw terminal and molex connectors

Logic operating voltage range 3.3V, 5V

Operating temperature 0 to 40°C

Storage temperature -40 to 70°C

Dimensions 68x54x30mm [2.6x2.1x1.2in]
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Features

• Arduino CNC Shield Version 3

• GRBL compatible. (Open source firmware that runs on an Uno that turns G-
Code commands into stepper signals (link)

• 4-Axis support (X, Y, Z , A - Can duplicate X, Y, Z or do a full 4th axis with 
custom firmware using pins D12 and D13)

• 2 x End stops for each axis (6 in total)

• Coolant enable

• Uses removable A4988 compatible stepper drivers. (A4988, DRV8825 and 
others)

• Jumpers to set the Micro-Stepping for the stepper drivers.

• Stepper Motors can be connected with 4 pin molex connectors or soldered 
in place

• Runs on 12-36V.  (only the DRV88825 driver can handle up to 36V so if 
using A4988 power supply voltage should not exceed 24V)

• Compact design
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https://github.com/grbl/grbl


The pinout

CNC Shield V3.0 has Uno compatible pins. The pinout is shown on the 
following image:

WARNING: Beware the orientation of driver boards. Wrong orientation will 

destroy the driver module.
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Extra pins

• Limit switch pins have been doubled up so that each axis has a “Top/+” 

and “Bottom/-”. This makes it easier to install two limit switches for each 

axis. (For use with a normally open switch)

• E-Stop – These pins can be connected to an emergency stop switch. 

This  does  the  same  as  the  RESET button  on  the  Uno board.  (It  is 

advisable that an extra EMERGENCY BUTTON is also installed that cuts 

power to all machinery. 

• Spindle and coolant control has their own pins.

• External GRBL Command Pins have been broken out allowing you to 

add buttons for Pause/Hold , Resume and Abort.

• Serial Pins (D0-D1) and I2C Pins (A4-A5) have their own break-out pins 

for future extensions. I2C can later be implemented later by software to 

control things like spindle speed or heat control.

• Version 3.00 of the board added jumper to configure the 4th axis (Clone 

the other axes or run from Pins D12-D13), Comm Header (RX+TX, I2C) 

and a Stepper Control Header (All Pins needed to run 4 steppers).
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CNC Shield V3

The CNC Shield is designed to take advantage of the demand for a low cost 

controller  solution for  DIY CNC machines.  It  was  designed to  be  100% 

compatible with GRBL, Open-source, G-code interpreter,  and fit  onto the 

popular Uno. The CNC Shield can be used to control a number of different 

types  of  CNC  machines,  including  CNC  milling  machines,  laser 

engraving/cutting machines, drawing machines, 3D printers or any project 

that needs precision control of stepper motors.  Compatible stepper drivers 

can be used, either A4988 or the higher current DRV8825.

There are three main components needed to get the CNC Shield up and` 

running:

1. CNC Shield

2. Stepper Drivers

3. Uno
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Stepper driver modules

Stepper driver modules in this bundle are based on A4988 driver chips. The 

A4988 is a complete micro-stepping motor driver with built-in translator for 

easy operation. It is designed to operate bipolar stepper motors in full-step, 

half-step,  quarter-step,  eighth-step,  and  sixteenth-step  modes,  with  an 

output drive capacity of up to 35V and ±2A.

NOTE: Output drive capacity is the maximum (recommended) value. It is 

advisable that drivers are not supplied with more than a 24VDC through the 

CNC Shield, otherwise it may burn out the stepper driver, even damage the 

shield and Uno.

Excessive  power  dissipation  of  the  driver  chip  results  in  a rise  of 

temperature that can go beyond the capacity of chip, probably damaging it. 

Even if the driver IC has a maximum current rating of 2A per coil, the chip 

can only supply currents around 1A per coil without getting overheated. For 

achieving more than  1A per  coil,  a  heatsink  or  other  cooling method is 

required. Our A4988 driver module comes with an aluminum heatsink. It is 

advisable to install the heatsinks before using the modules.

For more information on A4988 Stepper drivers there is an eBook that can 

be downloaded on the following link.
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https://www.az-delivery.de/products/a4988-modul-kostenfreies-e-book?variant=13546922016864


Component assembly

1. Insert the CNC Shield into the Uno making sure the correct pins of the 

CNC Shield are inserted into correct Uno headers.

2. Micro stepper settings may be setup for wanted application and place the 

jumpers as required.

3.  Insert  stepper drivers into the CNC Shield paying special  attention to 

match the enable (EN) pin to the enable socket.

4. Connect the stepper motor to the header pins. Check stepper motor to 

make  sure  the  correct  wiring  sequence.  Different  stepper  motors  have 

different wire colors. Check the stepper motor technical documentation to 

determine the right sequence.
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Jumper Settings

Jumpers are used to configure the 4th Axis, micro stepping configuration.
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The micro stepping can be configured for each axis. In the table below High 

indicates that  a  jumper  is  inserted  and  Low indicates  that  no  jumper  is 

inserted.

The  following  table  are  jumper  settings  configuration  for  A4988 stepper 

driver:

MS0 MS1 MS2 Microstep resolution
Low Low Low Full step
High Low Low Half step
Low High Low Quarter step
High High Low Eight step
High High High Sixteenth step 

The following table are jumper settings configuration for  DRV8825 stepper 
driver:

MODE0 MODE1 MODE2 Microstep Resolution

Low Low Low Full step

High Low Low Half step

Low High Low 1/4 step

High High Low 1/8 step

Low Low High 1/16 step

High Low High 1/32 step

Low High High 1/32 step

High High High 1/32 step
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Using two jumpers the 4th axis can be configured to clone the X or Y or Z 

axis. It can also run as an individual axis by using Digital Pin 12 for stepping 

signal and Digital Pin 13 as direction signal.

Clone X-Axis to the 4th stepper driver (Marked as A)

Clone Y-Axis to the 4th stepper driver (Marked as A)

Clone Z-Axis to the 4th stepper driver (Marked as A)

Use D12 and D13 to drive the 4th stepper driver (Marked as A)
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End - Stop configuration

By default, GRBL is configured to trigger an alert, if an end-stop goes low 

(Gets grounded). End-stop switch is standard  always open switch. These 

pins are used for  EMERGENCY BUTTON connection.
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Current Limit adjustment for Stepper driver 

(Reference voltage)

The way to set the current limit by measuring the voltage on the “ref” pin 

and to calculate the resulting current limit (the current sense resistors are 

0.100Ω). The current limit relates to the reference voltage as follows:

Current Limit = VREF × 2

For example, if a stepper motor is rated for 1 A, the current limit can be set  

to 1 A by setting the reference voltage to 0.5V.

NOTE: The coil current can be very different from the power supply current, 

so you should not use the current measured at the power supply to set the 

current limit. The appropriate place to put your current meter is in series 

with one of your stepper motor coils.

Reference  voltage  is  adjusted  via  small  trimpots  on  the  stepper  driver 

board. Adjusting the reference voltage in small increments is suggested - 

not more than a quarter turn at a time. For a starting point, set the max 

current to 1A. If the motor overheats, reduce the VREF. If the motor does 

not move or misses steps, increase the VREF.
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Stepper motors

When the stepper drivers are enabled they will make funny vibrating noises. 

This is normal. For more details have a look at this wiki page. The stepper 

drivers will get warm and need cooling if they are going to be used for long 

periods.  Small  heat  sinks  and  extractor  fans  are  advised. Having  extra 

stepper drivers is always handy. Some of the stepper drivers have thermal 

protection and will cut out if the temperature gets too high. This is a good 

sign that they need cooling or that they are overpowered.

- 16 -

http://en.wikipedia.org/wiki/Stepper_motor#Chopper_drive_circuits


How to set-up Arduino IDE

If  the Arduino  IDE is  not  installed,  follow the  link and  download  the 

installation file for the operating system of choice. The Arduino IDE version 

used for this eBook is 1.8.13.

For Windows users,  double click on  the downloaded  .exe file and follow 

the instructions in the installation window.
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https://www.arduino.cc/en/Main/Software


For Linux users, download a file with the extension .tar.xz, which has to 

be extracted. When it is extracted, go to  the  extracted directory and open 

the terminal in that directory. Two .sh scripts have to be executed, the first 

called arduino-linux-setup.sh and the second called install.sh.

To run  the first  script  in the terminal, open the terminal  in  the extracted 

directory and run the following command:

sh arduino-linux-setup.sh user_name

user_name - is the name of a superuser in the Linux operating system.  A 

password  for  the  superuser  has  to  be  entered  when  the  command  is 

started. Wait for a few minutes for the script to complete everything.

The second script, called install.sh, has to be used after the installation 

of  the first  script.  Run the following command  in the terminal  (extracted 

directory): sh install.sh

After the installation of these scripts, go to the All Apps, where the Arduino 

IDE is installed.
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Almost  all  operating  systems  come  with  a text  editor  preinstalled  (for 

example,  Windows comes  with  Notepad,  Linux Ubuntu comes  with 

Gedit,  Linux Raspbian comes with  Leafpad,  etc.). All  of  these  text 

editors are perfectly fine for the purpose of the eBook.

Next thing is to check, if your PC can detect an Arduino board. Open freshly 

installed Arduino IDE, and go to: 

Tools > Board > {your board name here} 

{your board name here} should be the Arduino/Genuino Uno,  as it can 

be seen on the following image:

The port to which the Arduino board is connected has to be selected. Go to: 

Tools > Port > {port name goes here} 

and when the Arduino board is connected to the USB port,  the port name 

can be seen in the drop-down menu on the previous image. 
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If the Arduino IDE is used on Windows, port names are as follows:

For  Linux users,  for  example  port  name  is /dev/ttyUSBx,  where  x 

represents integer number between 0 and 9.
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Library for Arduino IDE

To use the CNC Shield Bundle with Uno it is recommended to download an 

external library. The library that is  used in this eBook is  called the  GRBL, 

that can be downloaded on the following link.

When the .zip file is downloaded, open Arduino IDE and go to: 

Sketch > Include Library > Add .ZIP Library 

and add the downloaded zip file.

After installation of the  GRBL library, the code has to be uploaded to the 

Uno. To prepare the Uno for receiving the G-Code an example can be found 

at following: Files > Examples > grblmain

The G-Code can be sent from a specific software such as Universal G-code 

sender which can be found on Internet. There are many tutorials and guides 

on Internet how to operate and calibrate the Uno with a CNC shield for 

different purposes. Further explanations are not in the scope of this eBook.
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https://github.com/grbl/grbl


Now it is the time to learn and make your own projects. You can do that with 

the help of many example scripts and other tutorials, which can be found on 

the Internet.

If  you  are  looking  for  the  high  quality  products  for  Arduino  and 

Raspberry Pi, AZ-Delivery Vertriebs GmbH is the right company to get 

them from. You will be provided with numerous application examples, 

full  installation  guides,  eBooks,  libraries  and  assistance  from  our 

technical experts.

https://az-delivery.de

Have Fun!

Impressum

https://az-delivery.de/pages/about-us
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